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1 Introduction

Welcome to all EDC RC users!

The purpose of this manual is to serve both as a guide for installing EDC RC in a new record center
environment and as a technical reference for all technical aspects of EDC RC.

The technical part is more of a reference for the many different components/modules of EDC RC. This
part can be quite useful for the more technically inclined personnel who need to understand more in-
depth a specific part of EDC RC.

Who should read this?

This manual is NOT a User's Guide (If this is what you were looking for, please visit our web site.) and
hence will not show you how to use the day to day functions that most record center employees would
use in order to do their work. It is meant to be used by IT administrators and the likes or whoever
performs computer-related maintenance in your business. Basic knowledge of networking and system
administration is assumed here.

Your Feedback

Your feedback and opinion is very important to us. If you find errors in the document or have suggestions
on how to improve it, please feel free to send us your comments at support@docudatasoft.com . 

- The DocuData Team

mailto:support@docudatasoft.com
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1.1 Conventions used in this manual

This manual was created for both online viewing and print. When references to other topics are made
throughout the manual, they are made with hyperlinks to enable you to browse to the referenced topic
with a simple click of the mouse.

A page icon with the page number inside is always located to the right of the hyperlink to reference page
numbers when the manual is printed. The page icons looks something like this:

In this case it would mean that the referenced topic can be found on page 25 of the manual.

Example: Here is a reference to the start page  of the technical guide.55
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2 Install Guide

2.1 System Requirements

Technological Architecture

The Windows based system uses client/server architecture. The clients are Win32 based applications.

The Web based system is a multi-tier architecture using AJAX/JSP/Java and XML-RPC web services.

The internet browsers supported are:

– Internet Explorer 8 and above

– Firefox latest version

– Google Chrome (you may need to activate the Java plug-in for some document management

functionality)

– Apple Safari 6 and above

Server Platforms & Operating Systems

Windows 2003, 2008 or 2012

Workstation & Server Minimum Recommended Requirements

64 Bit Data Server

Micr

opro

ces

sor:

Athlon64, Opteron, Xeon or other Intel EM64T.

Dis

k

spa

ce:

500MB hard disk space for the application & the database engine + Data (average record

size – 2k/box, 1.5k/file). NTFS file partition for the database files that will be accessed.

Me

mor

y:

8GB or more.

 

Web Server

Microprocessor: Any Dual-core 2GHz or higher CPU will do but Quad-Core is better.

Memory: 2GB or more.
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Workstation

Operating System Vista / Windows 7 / Windows 8

Microprocessor Any Dual-core 2GHz or higher CPU will do

Disk Space 250MB hard disk space.

Memory 2GB RAM or better depending on operating system.

Recommended bandwidth between buildings: T1 Line or more

Bandwidth needed if serving electronic documents and images via ActiveWeb:

10 Mbit/sec up and down minimum, 100Mbit/sec recommended.

Communication Protocols

TCP/IP

Number of Concurrent Users

The Actian PSQL database server engine has 6, 10, 20, 50, 100, 250, 500 or an unlimited number of

users.

The Actian PSQL database workgroup engine permits up to 5 concurrent users.

Peripherals

Thermal printers (with Thermal Transfer Technology, Zebra or Datamax recommended)

LPT, USB or Ethernet Interface

Zebra ZM400 (industrial class)

Zebra Z4Mplus (industrial class)

Datamax I-4208 (industrial class)

Zebra S4M (medium class)

The model number on Zebra's mid-range thermal label printer have been changed

All thermal printers supporting Windows drivers

Bar Code Scanners

Wedge scanner: 
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Symbol, PSC, HHP or any other model capable of reading code 39 and 128 barcode labels.

Handheld:

` Opticon H13 (recommended model)

The portable unit is independent, with its’ own CPU and operating system. DocuData’s newest portable

unit features incredible response time and scan accuracy.

rcMobile

rcMobile uses HTML5 and requires a browser that is compliant with these standards.

Uses iPhone 4, 5, 6 with attached Linea Pro barcode scanner

Uses most Android smartphones with attached barcode scanner 

Laser Printers

Any Windows supported laser printer

EDC RC Software Server Requirements Guidelines

A Start-up Record Centre: may run ActiveWeb internally in “demo mode” for teaching and

demoing purposes, with minimal concern for performance or security.

o Have a back-up system that runs nightly and is tested periodically.

o Have anti-virus which is properly installed

o Have firewalls appropriately set.

Record Centers using ActiveWeb or rcMobile over the internet: will need internet security

that is at least consistent with the security requirements of their clients, taking into account the

type of information that they are storing.

o Have SSL installed

o Have better firewalls

o Have their Tomcat manager not exposed to internet

o Have the services of an IT professional who can provide advice on internet security.

o Have a security assessment done

Record Center selling ActiveWeb licenses: including EDM, ActiveFile Software Management

or imaging services or have clients running lots reports, will need to keep up with performance
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requirements and on-going hardware and software maintenance. This will increase costs and

they will need to consider this in their business plan budgets.

In general,

Every record centre that uses ActiveWeb should have a server with a 64-bit OS

If record centers are working with electronic documents and images must have a 64-bit OS.

Record Centers should be looking to increase performance to satisfy their customers and they should

set realistic expectations about what performance they can expect for their budget. Record centers

wanting to use ActiveWeb or rcMobile must realize they will need to invest in the necessary equipment

and network configuration.

2.2 Installation Procedures

This next section will show you how to install EDC RC from scratch. If you already have a working
version of EDC RC and just need to update to another version please refer to the section entitled 
"Updating EDC RC"  in the Technical Guide.50
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2.2.1 Installation Prerequisites

INSTALLATION PREREQUISITES

ftp://docudatasoft.com/record_center/Full

Actian Pervasive Database Software

There are three different versions (8, 9 and 10) & engine types (Server & Workgroup) of the Pervasive
Database that we support. Here  is an explanation of the differences between the two engine types
and versions of Pervasive. After reading thoroughly what the difference is you can then proceed to
download the version that is appropriate for you.

That said we do recommend that you always use the latest version available of Pervasive.

You can download Pervasive directly from the Pervasive website by following this link:

http://www.pervasive.com/psql/

MongoDB

MongoDB (https://www.mongodb.org/, ZIP 64-bit, latest downloadable)

Other Supporting Software

LibreOffice (https://www.libreoffice.org/,  latest downloadable)
PDF Printer (Bullzip PDF Printer Free, latest downloadable)

ActiveWeb, Tomcat Web Server and the Java Runtime Environment

One component of EDC RC is a Java-based web application called ActiveWeb. In order to get ActiveWeb
running you need to install the Tomcat Web Server and the Java Runtime Environment. Here are the
links:

Tomcat: https://tomcat.apache.org/download-70.cgi  (Download latest version 7 stable "Core" Windows
Executable binary distribution)
Java Runtime Environment: http://java.sun.com/javase/downloads/index.jsp  (Download latest JRE)

Get the serial and box numbers from us

If you don't have them already, get both the serial and box numbers from us by calling us toll free from
within Canada and the USA at 1-866-789-2789 or from anywhere else at (514)789-2789. You can also
send your request by email at support@docudatasoft.com if you prefer.

Ok now that you have all the required software we can go on to the install process itself.

58

http://www.pervasive.com/psql/
https://www.mongodb.org/
https://www.libreoffice.org/
https://tomcat.apache.org/download-70.cgi
http://java.sun.com/javase/downloads/index.jsp
mailto:support@docudatasoft.com
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2.2.2 Installing Pervasive

The first step in the install process is to install the Pervasive Database. Please refer to the Pervasive
documentation pertaining to your version and engine type for installation.

Note that Pervasive cannot be installed over a remote desktop connection.

Actian Pervasive Documentation  http://www.pervasive.com/database/Home/Resources/
Documentation.aspx

Once Pervasive is installed you should have a look at the "Optimized Pervasive Settings " section of
the Technical Guide to make sure your Pervasive settings are optimal for use with EDC RC.

60

http://www.pervasive.com/database/Home/Resources/Documentation.aspx
http://www.pervasive.com/database/Home/Resources/Documentation.aspx
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2.2.3 Installing EDC RC

The initial installation of EDCRC on your server is performed by DocuData. Please contact 
Support@docudatasoft.com to schedule an appointment when you are ready. 

mailto:Support@docudatasoft.com
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2.2.4 Installing EDC RC Services

EDC RC Services Setup

For EDC RC to function properly, 3 services need to be setup:

- The XML-RPC Server (edcrpc.exe)
- The Image Server (imgser32.exe)
- The Order Monitor Server (ordmon32.exe)

Note: The Order Monitor also needs to have the pager options set up in order to work. You'll find these
options in the Delivery Maintenance module under the File menu.

The way you install them is the same for all three of them with the exception that some services have
different command-line parameters available to them. So below is the procedure to both install and
uninstall an EDC service.

1. Start the windows command prompt
2. Browse to the bin folder of your EDC RC installation. The bin folder is located just underneath the root

folder. (by default it is located at C:\EDCRC\bin)
3. Then you simply enter the executable name followed by -install and then any special parameters if

needed. Here's an example for the XML-RPC service:

The command-line parameters available to these services are explained below. Note that these
parameters apply to all three services except where otherwise noted.

Command-line parameters
Note: the command-line parameters are NOT case-sensitive.

- cfgfile: This parameter indicates where to find the EDC configuration file "dc.cfg". Always use an
absolute path here. Relative paths have been known to cause problems in the past. If your absolute path
contains spaces, you need to enclose your path between double quotes as such: cfgfile="C:\path to\my
cfg file". Note that this parameter is mandatory for any EDC service install.

- servicename: This parameter indicates the name of the service itself. This is the name that you would
normally see when you open the services control panel from within windows. This parameter is optional
because there is a default name that is assigned to the service when you install it without that
parameter. Only use this parameter if you wish to change the default values.

Here is a list of default service names for each of the three services:

EDC Service (executable name) Default Service Name

XML-RPC Server (edcrpc.exe) EDC RPC

Image Server (imgser32.exe) EDC Image Server RC

Order Monitor Server (ordmon32.exe) EDC Order Monitor
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- portno: This parameter indicates what port you want the service to use for it's communications. Like
the servicename parameter, there is also some default port values that these services uses. Here is a
list of these default ports:

EDC Service(with executable name) Default Port Number

XML-RPC Server (edcrpc.exe) 11003

Image Server (imgser32.exe) 11000

Note that these port numbers should not be changed unless you have absolutely have to. Also be sure
that the port numbers you set for the XML-RPC and the Image Server match the numbers
indicated in the system information module of EDC RC.

- ssl: This parameter is only used by the XML-RPC Server and indicates if the communication with
the server is encrypted or not. This setting also has to match what is written in the system information
module of EDC RC. The possible values for this parameter are "yes" or "no".

A reference of all the available command-line parameters for the EDC RC services can be found in the
Technical Guide under the "Command-Line Parameters" section.
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2.2.5 Uninstalling EDC RC Services

How to uninstall EDC RC services

If you wish to uninstall an EDC RC service, the usual procedure is simply to browse to the bin folder of
your installation with the command prompt and type the name of the executable with the -uninstall
switch. Here's an example:

The only exception to this is if you installed the service with the servicename parameter. In that case
you need to specify the servicename to uninstall it as well like so:
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2.2.6 Installing MongoDB

1- Download the latest 64 bit MongoDB "Production Release" install package:

http://www.mongodb.org/downloads

Note: The "64-bit legacy" option is for Windows 2003 & 2008 servers.
      The normal 64 bit download is for 2012 or "2008 R2" servers.

2- Unzip the archive to C:\mongodb so that when going inside this folder you will
   see these 4 items:
   
- a "bin" folder
- "GNU-AGPL-3.0" file
- "README" file
- "THIRD-PARTY-NOTICES" file

3- Inside your DocuData "EDC RC" folder there is a "data" folder. Create a new "mongodata"
   folder inside this "data" folder.
   
4- Inside the C:\mongodb folder create a folder called "log" and a file called "mongod.cfg"

5- Inside the "mongod.cfg" enter these lines and save the file:

dbpath=here put the path to your "mongodata" folder created in step # 3 above.
logpath=C:\mongodb\log\log.txt
bind_ip=IP address of the EDC server where mongo is installed

6- Install MongoDB as a service by running this command from the command prompt:

Note: You must make sure that User Account Control (UAC) is not enabled on your Windows account
otherwise the service won't install.

For the RC Software:
C:\mongodb\bin\mongod.exe --config C:\mongodb\mongod.cfg --install

7- Go to the windows services and make sure the "Mongo DB" service "startup type" is
   set to "automatic".
   
8- Start the service

Note: from a batch (for backup purposes for example) script you can always start and stop
      the "Mongo DB" service with these commands:
      
net start MongoDB
and
net stop MongoDB

At this point if the service doesn't start it is most likely because the settings in the
"mongod.cfg" file have a typo in there. Recheck them.
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9- Test MongoDB to make sure connections can be made to it by using from the command line:

For the RC Software:

c:\mongodb\bin\mongo 127.0.0.1:27017
*** Replace 127.0.0.1 with the IP address of the server, leave the default port alone.

To connect and then try:

show dbs

to see a listing of current databases. Only the "local" database should be present at this
time.

Exit the command prompt by typing:

exit

and then press "enter".

2.2.7 Client Installation Package Configuration

Before a record center client can install the EDC Client software, preparation must first be done at the
record center. This section will explain how to do this preparation.

Preparation at the Record Center

At the record center, the process EdcRpc.exe, is the server that must be available to extract the
customer's data. This process should already installed as it is the same process used for the EDC
Replication. If it is not installed, please refer to the "Replication"  section in the Technical Guide later
in this manual.

In addition to the EdcRpc.exe process executing, the RPC Server at RC fields must be properly
configured to reflect the external IP address, port, and encryption option for the EdcRpc.exe server.

Client Installation Package

In the System Information module, there is a field called, Client installation folder. This field must
indicate the folder where the Client Installation Package is located. This package is a single
compressed file with a name like:

EdcClientInstall_1020_20050427.zip

The file must be obtained from DocuData. The contents and name of this archive must not be modified in
any way. The number before the date, for example, 1020 in the above file name, is the database level of
the client software within the archive. It must match the client database level at which the record center
will export. To verify that, display the dialog box from the Help | Resources menu of EDC RC. This will
show a dialog box similar to:

74
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The client database level of EDC RC is CL001020 so this matches the level 1020 of the client installation
package.

Client installation packages for different database levels are available on the Internet via FTP, 

ftp://docudatasoft.com/record_center/ClientInstallationPackage/

Preparing a client before installation

Before the EDC Client software is installed using the Client Installer, the following must be done by the
record center:

A supervisor group and user must be added to the Customer if such group and user does not exist.
Define a password of the supervisor user. The user name and password of the supervisor user must be
communicated to the client, if the client does not know it. 
Add delivery addresses to the client in the Delivery Address module, if it has not already been done.
Assign the delivery types that the client has rights to in the Customer module, if it has not already
been done.
A default department and sub-department should be added if this is a new customer. This will avoid
the client from having to create them in order to add boxes and files.
A default document type should be added if this is a new customer. This will avoid the client from
having to create one in order to add boxes and files.

If you need more information on how to set the Client Installation Package please contact 
support@docudatasoft.com

mailto:support@docudatasoft.com
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2.2.8 Other Services Settings and Dependencies

Other Services Settings and Dependencies

There is a few more settings to set before the EDC RC services are all ready to run in a production
environment. Also all EDC RC services depend on the Pervasive database service to run. So we need to
set a Pervasive dependency for every service. Here's how we do it:

1- You need to add a value in the registry of each EDC RC service. You need to browse (with regedit.
exe) to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services. Once there you just have to
find the EDC service you wish to edit. All EDC services start with EDC by default and so it should make
it easy to find them.

2- Then you have to add a string value with the name "DependOnService" and put the Pervasive service
name as the value. If you have 2 Pervasive services running (Relational & Transactional), use the
Pervasive Transactional service name. Here's some screenshots that should help you accomplish this
task:

Here's what you should find in the registry before you start editing:

Adding the value:

The value you need to put in the "Value data" field is the name of the service as shown in the service's
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properties like so:

We're done with setting the pervasive dependency. Once this is done you will see the dependency in the
dependencies tab of your EDC service like so:
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The last thing to do now is set the service's restart options in case something goes wrong at the startup
of the computer. To do this we go to the recovery tab of the EDC service and set the first and second
failure options to "Restart the Service" like so: 
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That's it! The EDC RC services are now ready for production use. Now the last part of the setup consist
of setting up the web part of EDC RC: ActiveWeb.
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2.2.9 ActiveWeb Installation

2.2.9.1 About ActiveWeb

ActiveWeb is a component of the EDC record center software. It is a web based solution to manage
semi-active documents located at a record center. It is deployed to provide web access to the clients of
the record center.

ActiveWeb uses a scalable multi-tier architecture consisting of the following:

An internet browser. 
A web server with Java Server Pages (JSP) support. Tested on Tomcat, the reference JSP
implementation.
The EDC RC XML-RPC multi-threaded server.
The EDC RC database.
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2.2.9.2 Required Software

EDC

Before installing ActiveWeb, the EDC RC software and application must be properly installed.

The ActiveWeb application is deployed in a java WAR file having the name "rcweb.war".

Java SE Runtime Environment

ActiveWeb requires the Java SE Runtime Environment (JRE). The JRE is free of any licensing costs. The
latest 64-bit version, which is version 8 may be downloaded from:

http://www.oracle.com/technetwork/java/javase/downloads/index.html

Choose the Windows Offline installation package. This will make the install easier.

Tomcat Servlet Container

The Tomcat servlet container and integrated web server is the recommended JSP environment. Tomcat
is free of any licensing costs. Download the latest 7 version, which may be downloaded from:

http://tomcat.apache.org

The file to download is: Windows Service Installer - core binary distribution

http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://tomcat.apache.org
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2.2.9.3 Installing the JRE and Tomcat

Important: Before installing the Java Runtime Environment and Tomcat, the current user must have
administrator rights.

Installing the Java Runtime Environment

To install the JRE, launch the executable Java program downloaded previously, which is version 8, 64-bit

executable (or later version). Select the Typical setup type, and complete the installation wizard. This
may require a reboot of the workstation.

Installing the Tomcat Servlet Container

Note: Tomcat should be installed in a DMZ separate from your internal network for better
security. Some information about DMZ's can be found here:

http://en.wikipedia.org/wiki/DMZ_host

To install Tomcat, launch the

executable (latest 7 version). It is recommended to enter a password for the Tomcat "admin" user when
prompted.

Note: Tomcat will install by default on port 8080. This can be a problem with some companies that have
that specific outgoing port blocked. We recommend that you install Tomcat on port 80 when prompted. If
this is a problem for you because you have another web server running on port 80, you could possibly:

1- Use only Tomcat as your main web server if Tomcat can handle your other website's requirement
specifications properly. Consult Tomcat's documentation for more info on this. Tomcat's documentation
can be found here:

https://tomcat.apache.org/tomcat-7.0-doc/index.html

2- Use a "Tomcat Redirector" plug in in your current web server to redirect all java-based requests to
Tomcat for processing. Consult your current web server's documentation to see if this option is available
to you. If you are using Microsoft's IIS web server already, refer to the section "Tomcat & IIS " later in
this manual for Tomcat redirector options. 

Tomcat is installed as a Windows service. By default, it is configured to start manually. This should be
changed to "automatic". This can be changed using the Configure Tomcat utility (available in the Start
menu) or in the Windows service manager. The Configure Tomcat utility is shown below:

42

http://en.wikipedia.org/wiki/DMZ_host
https://tomcat.apache.org/tomcat-7.0-doc/index.html
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The service should be started at this point.

Opening the page,

http://127.0.0.1:8080/

on the workstation where Tomcat is running should display a page similar to:

http://127.0.0.1:8080/
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Note: Make sure you configure Tomcat so that external users cannot access anything BUT "ActiveWeb".

Especially you don't want them to be able to "see" the startup page of Tomcat as seen in the screenshot

above. Read the Tomcat documentation to understand how to do this.
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2.2.9.4 Configuring the EDC RPC Server

The ActiveWeb application will communicate with the EDC software using the EDC remote procedure
call (RPC) server. This server process is executed using the EdcRpc.exe file.

Executing as a regular process

By default, if it is executed without any command line parameters it will listen on TCP port 11003. To run
the server on a different port, the following can be used:

EdcRpc.exe PortNo=14000

The parameters are not case sensitive.

Executing as a service

To install as a service, the following command must be used:

EdcRpc.exe -install PortNo=14000 CfgFile=C:\EDC\Bin\Dc.cfg

By default, the name of the service in the Service Manager, is "EDC_RPC". A different service name
may be specified using,

EdcRpc.exe -install ServiceName=EDC_RPC_1 PortNo=14000 CfgFile=C:\EDC\Bin\Dc.cfg

To uninstall the previously installed service,

EdcRpc.exe -uninstall ServiceName=EDC_RPC_1

The ServiceName parameter is required with the -uninstall command if it was specified during the install
command.

For more information on how to setup EDC Services, refer to the "Installing EDC RC Services"
section of the Install Guide.

14
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2.2.9.5 Installing ActiveWeb via the Deploy Wizard

Since version 5.11.02 EDC RC has a "Deploy Wizard" to help you deploy ActiveWeb on your web
server. This deploy method is the preferred way to install and/or update ActiveWeb. If you update
ActiveWeb in any other way you might loose some customizations & settings that were
previously there before you update.

Note: To be able to use this wizard you need to have the Java SE Development Kit (JDK)
installed on your machine. The JDK is available from this page:

http://java.sun.com/javase/downloads/index.jsp

This deploy wizard is accessible from the "System Information" module in EDC RC under the File menu
like so:

When you launch the wizard you first get this window:

http://java.sun.com/javase/downloads/index.jsp
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You click "Next" to get to the following screen:
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Here you have to enter the URL that points to your Tomcat Web Server (Host) and the credentials (User
& Password) of the "admin" user in the Tomcat Manager.

Note: If you forgot the credentials and/or need to reset them, you'll find this information inside
the file "tomcat-users.xml" located in the "conf" folder of your Tomcat installation. In a default
installation that folder is located at:

C:\Program Files\Apache Software Foundation\Tomcat 5.5\conf

After you've entered the URL, credentials and clicked "Next" you'll get this window:
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In this window you need to specify the SERVER NAME that hosts the EDC RC RPC SERVER "edcrpc.
exe", the port and wether the RPC SERVER is using SSL encryption or not.

Note: If you're unsure what these settings are, refer to the "System Information" module of EDC
RC under the "Replication" section. Use the "Internal LAN" setting for the "RPC Server Name"
and use the port and ssl settings therein as well.

When you're done click "Next" to get to the following screen:
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This screen asks you the location of the "WAR file to deploy" as well as the "Application Name". By
default the "WAR" file is located in the "bin" folder of your EDC RC.

If you cannot find it there please contact support@docudatasoft.com to get the file. When asking for this
file please also indicate what version of EDC RC you are using. You can get this version information by
going to the "Help -> About" menu item after launching EDC RC.

The "application name" is the name that will be used in the URL to the application. So for example if you
name your application:

the_amazing_web

your URL will be similar to:

http://www.yourdomain.com/the_amazing_web/

Note: Do not use any space if you choose many words. Use the "_" (underscore) to tie the
words together like I've done in the example above (the_amazing_web).

When you click "Next" you will see this screen:

mailto:support@docudatasoft.com
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In this page you can customize options like:

- Number of search results per page
- Number of columns for previewing images belonging to Files
- Location of the search panel
- Choosing from 1 of 3 pre-defined color schemes or choose each colors individually

When you click "Next" you will be told where the image folder of your ActiveWeb application resides like
so: 
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The images in this folder can be modified and will be remembered when you do another update. Then the
next screen simply tells you that you are about to deploy ActiveWeb like so:
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And then a confirmation dialog just in case you change your mind about some options before installing.

If you click "Yes" the wizard will try to connect to the web server to initiate the install. If for some reason
it cannot connect you will get a message like so:

You will also receive a warning if the connection is successful but there is active sessions(users)
currently in use:
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Note: If you answer "Yes" to this dialog box you will kick out any user from their session and
they will have to retry the operations they were trying to make when they got kicked out.

When the install is complete you will get a window telling you so:

At this point you can simply browse to your ActiveWeb installation to verify that you can login
successfully.

This completes the ActiveWeb installation via the Deploy Wizard.

If you have any questions please contact support@docudatasoft.com 

mailto:support@docudatasoft.com
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2.2.9.6 Running ActiveWeb in a Web Browser

Once the EDC RPC server, Java JRE, and Tomcat servlet container, are installed, configured and
started, the ActiveWeb web interface can be accessed via a web browser.

If Tomcat is executing on the same computer as the web browser, the ActiveWeb application can be
access via the following URL:

http://localhost:8080/ActiveWeb/

If communication is properly established with the EDC RPC server the following login page will appear:

Note: All the captions used in ActiveWeb can be modified in the EDC dictionary module.

http://localhost:8080/rcweb/
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2.2.9.7 Integrating SSL Security within Tomcat

If you want to encrypt your communications to and from ActiveWeb you need to configure your Tomcat
installation to use SSL (Secure Sockets Layer) security. 

The Tomcat documentation explains how to do this. Browse to:

http://tomcat.apache.org/tomcat-5.5-doc/ssl-howto.html

for the instructions.

If you are using Tomcat as a redirection plug in for another web server such as Microsoft's IIS, refer to
that other server's documentation for SSL setup.

http://en.wikipedia.org/wiki/Secure_Sockets_Layer
http://tomcat.apache.org/tomcat-5.5-doc/ssl-howto.html
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2.2.9.8 Modifying the session timeout

After a certain amount of user inactivity in a session, ActiveWeb will terminate the session for safety and
performance reasons. The timeout is configurable for the whole website, per customer and per user.

1- Setting the timeout for the whole website

To set the timeout for the whole website, add the following command line parameter to EdcRpc.exe:

   EdcClServiceAtRC.TimeOut=[number of minutes]

2- Setting the timeout for a customer

To set the timeout differently for a particular customer go in the "Customer Information" module of EDC
RC and modify the "Web Time Out" to a value (in minutes) of your choice. If you leave the setting at
"default" it will use the timeout value that is set for the whole website on the command line as in point #
1 above.

3- Setting the timeout for a user

To set the timeout differently for a particular user go in the "Authorized User" module of EDC RC and
modify the "Web Time Out" to a value (in minutes) of your choice. If you leave the setting at "default" it
will use the timeout value that is set for the customer in the "customer information" as in point # 2 above.
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2.2.9.9 Tomcat & IIS

Tomcat can also be used as a plug-in in Microsoft's IIS web server for java-based request processing. It
works in a similar fashion as what a cgi script would do:

1- Request is first being received by IIS.
2- IIS determines it is a java-based request.
3- IIS redirect the request to Tomcat for processing.
4- Tomcat returns the processing result to IIS.
5- IIS returns the result to the requesting web browser.

Note: Tomcat and IIS should be installed in a DMZ separate from your internal network for
better security. Some information about DMZ's can be found here:

http://en.wikipedia.org/wiki/DMZ_host

There is 2 common ways to install Tomcat as an IIS plug-in:

1- Use the free redirector plug-in provided by the Apache Software Foundation
2- Use a commercial plug-in from a software vendor

Use the free redirector plug-in provided by the Apache Software Foundation

- Install latest Java JRE from:

http://www.oracle.com/technetwork/java/javase/downloads/index.html

Note: if your server is 64 bit install the 64 bit version otherwise install the 32 bit version. At the time of
this
writing the latest version was "Java SE 7u9".

- Install latest Tomcat from:

http://tomcat.apache.org/

Note: at the time of this writing the latest version is 7.0.33. You have to use the "32-bit/64-bit Windows
Service Installer".

- Install the Tomcat Connector:

Go to: http://tomcat.apache.org/download-connectors.cgi

click on "Binary Releases" and then "windows".

Download the latest "x86_64-iis.zip" file. If your web server is 32bit only download the latest "i386-iis.zip"
file.

At the time of this writing it was:

tomcat-connectors-1.2.37-windows-x86_64-iis.zip
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or

tomcat-connectors-1.2.37-windows-i386-iis.zip
 
 - Create the folder "C:\Program Files\Apache Software Foundation\Jakarta Connector".
 
 - Copy isapi_redirect.dll from the zip file you just downloaded to:
 
 "C:\Program Files\Apache Software Foundation\Jakarta Connector\isapi_redirect.dll"
 
 - Right click on "isapi_redirect.dll", choose properties and click the "Unblock" button.

 - Create a file "C:\Program Files\Apache Software Foundation\Jakarta Connector\isapi_redirect.
properties".
 
 - Add the following content to this file:
 
extension_uri=/jakarta/isapi_redirect.dll
log_file=C:\jk\isapi_redirect.log
log_level=trace
worker_file=C:\Program Files\Apache Software Foundation\Jakarta Connector\workers.properties
worker_mount_file=C:\Program Files\Apache Software Foundation\Jakarta Connector\uriworkermap.
properties

 - Create a file "C:\Program Files\Apache Software Foundation\Jakarta Connector\workers.properties".
 
 - Add the following content to this file:
 
ps=\

worker.list=wlb

worker.ajp13w.type=ajp13
worker.ajp13w.host=localhost
worker.ajp13w.port=8009

worker.wlb.type=lb
worker.wlb.balance_workers=ajp13w

 - Create a file "C:\Program Files\Apache Software Foundation\Jakarta Connector\uriworkermap.
properties".
 
 - Add the following content to this file:
 
/activeweb=wlb
/activeweb/*=wlb

Note: If you use another name than "activeweb" in your deployement, use that name instead.

Configure IIS7:
---------------

 - Open Internet Information Manager.
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 - Select the server.
 
 - Double click on the "ISAPI and CGI Restrictions" icon.
 
 - Click on "Add..." in the Actions on the right and use the followin informations:
      ISAPI or CGI Path: "C:\Program Files\Apache Software Foundation\Jakarta
Connector\isapi_redirect.dll"
      Description: jakarta
      Allow extension path to execute: Chekced
      
 - Click on "Default Web Site"
 
 - Double click on ISAPI Filters.

 - Click on "Add..." in the Actions on the right and use the followin informations:
      Filter Name: jakarta
      Executable: C:\Program Files\Apache Software Foundation\Jakarta Connector\isapi_redirect.dll

 - Right click on "Default Web Site"
 
 - Select "Add Virtual Directory" and use the followin informations:
      Alias: jakarta
      Physical path: C:\Program Files\Apache Software Foundation\Jakarta Connector
      
 - Select the jakarta virtual directory
 
 - Double click on "Handler Mappings".
 
 - Click on "Edit Feature Permissions..."
 
 - Check the Execute option.
 
 - Select the server.
 
 - Click on the "Restart" option.

Done!

Troubleshooting
---------------

If after doing these steps you find out redirection does not work it is 99.9% due to the fact that IIS has
some
modules or options missing. Try this first:

- Make sure that under the "Handler mapping" of the jakarta virtual folder you do have "*.dll IsapiModule"
enabled if you
don't the "isapi_redirect.dll" won't be able to load and instead of getting the start page of ActiveWeb the
webserver may ask you
to download some file instead. If you don't have it install it. See screenshot:

http://docudatasoft.com/supportfiles/documentation/ActiveWeb/jakarta_handler_mappings.jpg
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- If you do have the dll module installed then perhaps IIS is missing some "roles":

http://docudatasoft.com/supportfiles/documentation/ActiveWeb/IIS_roles.jpg

We are not sure which roles exactly IIS requires for the redirection to work but you can start with the
highlighted ones
on the screenshot and then add some more if need be until you find exactly which one is missing. Not
sure also if the web
server will require a restart after adding roles.

If you have any questions about this please email support@docudatasoft.com for more info.

Use a commercial plug-in from a software vendor

If you find that installing the free plug-in is too complicated for you or you find that you don't have enough
time to figure it out there is always some companies that offer their own commercial plug-ins for a fee.
These companies can also generally help you out with the installation for an additional fee.

Here is a company that we know provide such services:

http://www.neurospeech.com/Products/JspISAPI.aspx

This is the actual company that one of our client uses with success.

This concludes the section on Tomcat & IIS.

http://www.neurospeech.com/Products/JspISAPI.aspx
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2.2.9.10 Required Access Rights

ActiveWeb users need to have certain access rights available to them prior to use ActiveWeb in order to
use it effectively. Please refer to the section entitled "ActiveWeb" in the EDC RC User's Guide for help
on setting those access rights.
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2.2.9.11 Troubleshooting

Internal error on the login page

If the \ActiveWeb\config.ini file is not configured properly, or the EdcRpc.exe process is not running, an
error similar to the image below will be displayed when trying to login:

The address and port (as specified in the config.ini file) that the JSP application is trying to connect to is
indicated in the error message. To resolve the situation, ensure the EdcRpc.exe process is executing,
and the \ActiveWeb\config.ini file is properly configured.
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Images do not appear within ActiveWeb

When displaying images within ActiveWeb, if the images do not appear, as displayed below,

This indicates the EDC Image Server is not executing or not configured properly. See the System
Information module to configure the Image Server parameters.

Box or File Content does not display

If you can't view the content of a box or file AND you encounter this error:
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It could be because you have some invalid characters in your item's content. A quick way to see if this
is the case is this:

1- Find the Item you want to view in EDC RC itself not ActiveWeb.
2- Once the item is found, press the "Edit" button on the toolbar or go "Edit - > Edit" from the top menu.
This will put the item in edit mode. You don't need to actually change any information, just put the item
in edit mode.
3- Once the item is in edit mode, put it back to normal mode simply by clicking the "Accept" green
arrow and you're done.

By doing this action, all invalid characters for the item have been removed or stripped. Now the item
should be visible in ActiveWeb as usual.
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3 Update Guide

This section will show you how to update an already working version of EDC RC. Three different updates
have to be performed:

EDC RC
ActiveWeb
PDT

Just follow the pertinent links above for instructions.
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3.1 Updating EDC RC

It is of utmost importance that you read this section thoroughly before attempting an update of
EDC RC. Failure to do so can result in unpredictable behavior of EDC RC or worse, could
irreparably damage your current installation and/or data. If in doubt about anything mentioned
here below, contact us directly at (514)789-2789 or by email at: support@docudatasoft.com
before attempting the update.

NOTE: If your version of EDC RC is 4.50.64 or below, you MUST contact us before upgrading to this new
version because it introduces some changes to the normal operations work flow that you won't be aware
of without.

Steps you need to do before starting the update process

1- Download the update file (zip file) if you don't have it already. 

2- Make sure you have a recent and functioning backup of you whole EDC RC installation (including the
data if on a different server).

3- Make sure no workstation is running EDC RC or EDC Client.

4- Close all EDC services and/or processes running.

How to perform the update process itself

1- From the zip file you just downloaded, extract the file called "Update.exe" and put it in the "bin"
directory of your EDC RC installation. Overwrite the older file if prompted to do so.

2- Put the zip file itself in the Update directory of your EDC RC installation.

3- Run the Update.exe file and follow the prompts until the update is finished.

Note: Once the update is complete, the update file will be renamed with a .ZI# extension. You may want
to keep it, this will enable you to recuperate specific files of the update if needed later on. 

Note: The results of the update are saved in a file called UPDATE.LOG in the Update directory of your
EDC RC installation.

4- Update your ActiveWeb installation by following the instructions located here .

Note: The rcweb.war file is located inside the zip file you downloaded earlier on.

5- Update your PDT by following the instructions located here .

6- Either restart your computer or just the services/process of EDC and Tomcat depending on your
situation. (You probably won't want to restart your whole computer if you have other applications running
on it that have users connected to. For example a web server.) If you only need to restart the processes
of EDC RC in the event that you don't have them installed as services, here's the executable names you
should be looking for inside the bin folder of your installation:

EdcRpc.exe
ImgSer32.exe 
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7- Test your new update by starting EDC RC and running ActiveWeb.

That's it!

Hopefully everything went smooth and well for you and you didn't have any problems. However if you did
have some problems, don't hesitate to contact us straight away by telephone at 1-866-789-2789 for
North American customers, (514)789-2789 for customers outside North America or by email at 
support@docudatasoft.com .

mailto:support@docudatasoft.com
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3.2 Updating ActiveWeb

The update method for ActiveWeb is the same as for installing it so please refer to the section "Installing
ActiveWeb via the Deploy Wizard"  earlier in this manual.30
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3.3 Updating your PDT

The update method for the PDT is the same as for installing it so please refer to the section "Portable
Data Terminal (PDT)"  in the Technical Guide.98
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4 Technical Guide

This part of the manual aims at giving you some technical information that might be useful to you for
understanding how EDC RC works.

As such, it is more of a reference into the inner workings and relations between the different processes
of EDC RC. This can be quite useful for the more technically inclined personnel who wish to understand
more in-depth the "why's" of EDC RC.



EDC RC Technical Manual56

© 2015 DocuData Software Corporation

4.1 Pervasive Database Software

This part of the manual gets into the nitty gritty details of the Pervasive Database. If you need more
information about Pervasive you can visit their website at www.pervasive.com .

http://www.pervasive.com
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4.1.1 The Pervasive Control Center(PCC)

The Pervasive Control Center(PCC) is one the tools most often used for the maintenance of the Actian
Pervasive Database. You can find documentation on how to use it under the chapter "Using Pervasive
PSQL Control Center" in the Pervasive User's Guide that comes with your installation or online at:

http://docs.pervasive.com/products/database/psqlv11/wwhelp/wwhimpl/js/html/wwhelp.
htm#href=welcome/libwelcome.html (For Actian Pervasive Databases v. 11)

Pervasive also contains other utility programs to help you manage other aspects of the database. These
utilities are:

-  Function Executor
-  License Administrator
-  Maintenance
-  Monitor 
-  Rebuild
-  Pervasive System Analyzer
-  ODBC Administrator

Refer to your Pervasive documentation for the use of these utilities.

http://docs.pervasive.com/products/database/psqlv11/wwhelp/wwhimpl/js/html/wwhelp.htm#href=welcome/libwelcome.html
http://docs.pervasive.com/products/database/psqlv11/wwhelp/wwhimpl/js/html/wwhelp.htm#href=welcome/libwelcome.html
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4.1.2 Differences Between Engine Types and Pervasive Versions

Differences between the server and workgroup engine in version 11 of Pervasive

Platforms

The NetWare and Linux engines are server engines only. Our Windows server engine and the Workgroup
engine require a Windows 32-bit platform.

User Interface

While the Windows server engine runs as a service, the Workgroup engine is started as a regular
process that has a tray icon for an interface. It must be put into the startup folder if there is local data to
be shared.

Network Connections

The Windows server engine can use Named Pipes for operating system level file security and
establishing connections. Since Windows 98/ME does not allow the creation of named pipes, the
workgroup engine uses NetBIOS as a connection protocol.
Authentication and Btrieve Security Policies

The server engine enforces file permissions set up in the operating system. The Workgroup engine does
not authenticate users on its own. With the Workgroup engine, if you can see the computer on the
network, you can get to the data. This relaxed security is intended for small offices where security is not
an issue and ease of use is.

A behavior difference between the Server and Workgroup engines with regard to this lack of OS
authentication on the part of the Workgroup engine is that the Mixed security policy for Btrieve is the
same as the Classic security policy.

Gateway Support

The Workgroup engine creates locator files everywhere it opens files, allowing the engine to dynamically
adjust gateway ownership on a day-to-day basis. By default, the Workgroup engine also runs under a
user ID, which can be authenticated on other computers and network devices. The Server engine runs as
system services. The services typically do not have access rights to files on other computers or network
devices. Therefore, replacing a Workgroup engine with a Server engine as a gateway in a workgroup
environment is not supported.

User Counts

The server engines start at 10 concurrent connections and the Workgroup engine starts at 5.

Asynchronous I/O

The server engine for Windows makes use of Asynchronous I/O. This feature can provide a significant
performance advantage.

There is a lot of new features in Actian Pervasive 11 SP3 but we won't cover them here. The Pervasive
website has all this information for you here:
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http://docs.pervasive.com/products/database/psqlv11/wwhelp/wwhimpl/js/html/wwhelp.
htm#href=welcome/libwelcome.html

.

http://docs.pervasive.com/products/database/psqlv11/wwhelp/wwhimpl/js/html/wwhelp.htm#href=welcome/libwelcome.html
http://docs.pervasive.com/products/database/psqlv11/wwhelp/wwhimpl/js/html/wwhelp.htm#href=welcome/libwelcome.html
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4.1.3 Optimized Pervasive Settings

In general Pervasive's settings don't need to be modified. However, there are options that we suggest you
change in order to optimize Pervasive. Included herein are the settings appropriate for servers  and
workstations .

These settings apply to Pervasive versions 8.x up to version 9.x unless otherwise noted and are editable
directly from the Pervasive Control Center. Note that these settings CANNOT be set via a remote
desktop connection.

SERVER SETTINGS

To access the server settings inside the control center, browse to Configuration -> Server as shown
below :

Pervasive 8 Control Center

Pervasive 9 Control Center

Here's the server settings that you can change. The settings will be described from top to bottom as
seen in the picture above (From Access to Performance Tuning).

Access

Allow Cache Engine connections: On

This option specifies if the server will support clients that will attempt to connect to the server with the
client cache engine. When set to Off, clients will still connect to the Server but will not use the client
cache engine.

60
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Communication protocols

Enable auto reconnect :on

This setting specifies whether you want the server to support clients attempting to auto-reconnect during
a network outage.

Supported protocols: TCP only (if using TCP of course)

This setting specifies the protocols on which the database engine listens for client connections. If more
than one protocol is specified, the database engine listens on all specified protocols and slows down the
initial connection time.

Data integrity

Transaction Logging = On

When this value is "On", transaction atomicity and multi-file data integrity are guaranteed. Offer less
transaction recoverability that Transaction Durability, but more performance. If Transaction Durability is
on, this setting is ignored.

Transaction Durability = Off

When this value is "On", the MicroKernel does not return a successful status code for an "End
Transaction" operation until the transaction is completely written to the log file. 

When turned ON this feature will slowdown the speed of your database operations but will ensure better
recoverability of your data in the event of a system crash or other unanticipated problems.

Memory Usage

System cache: Off

Using the Windows system cache adds more overhead in general. If the Pervasive cache allocation size
 is large enough, there is no need for the system cache.

Performance Tuning

Cache Allocation Size: Between 20% and 40% of your total physical memory size.

This setting is dependant on many factors (Database file sizes, total amount of physical memory, how
many applications are running on the machine etc...).

Here is what the Pervasive documentation says on the issue (important to read):

"Speak ing very generally, overall performance is usually best when the Cache Allocation Size is a value
less than 40% of the physical memory on the system, and the Configuration setting Max MicroKernel
Memory Usage  is set to a value greater than 40%. Your exact optimal settings will depend on the
size of your data files, the number of other applications running on the system, and the amount of
memory installed in the computer. 

Server Engine 
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On Windows, this setting is initially set to 20% of physical memory by the database engine the very first
time it starts up, and it writes that value to the Registry. After that, whenever the engine starts up, it
reads the value from the Registry. Changing the value using Configuration updates the value in the
Registry. If you add or remove memory from the system, you must modify this setting to take best
advantage of the new amount of memory available. 

To optimize your performance, allocate a cache size no larger than the sum of the sizes of the files you
are using. However, be careful not to take all available memory, especially when the server is running
other applications. You cannot improve performance-and may waste memory-by specifying a value
higher than you need.

Workgroup Engine and Client Cache 

The database engine initially sets this value the very first time it starts up, and it writes the value to the
Registry. The value is set to 20% of physical memory, up to a maximum of 32 MB. After the Registry
setting is initialized, whenever the engine starts up, it reads the value from the Registry. The engine
never re-calculates the setting. Changing the value using Configuration updates the value in the
Registry. If you add or remove memory from the system, you must modify this setting manually to take
best advantage of the new amount of memory available. 

This information also applies to the client software (client cache) if the Configuration setting Client |
Performance Tuning | Use Cache Engine is turned on."

Max Microkernel Memory Usage: 50

This setting works in conjunction with the Cache Allocation Size setting just above. Refer to the
Pervasive Documentation if you need more info.
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WORKSTATION SETTINGS

To access the server settings inside the control center, browse to Configuration -> Client as shown
below :

Pervasive 8 Control Center

Pervasive 9 Control Center

Here's the server settings that you can change. The settings will be described from top to bottom as
seen in the picture above (From Access to Application characteristics).

Communication protocols

Enable Auto Reconnect : On

This setting specifies whether you want the client to attempt to auto-reconnect during a network outage.

Supported protocols: TCP only (if using TCP of course)

This setting specifies which protocols are available to the requester when connecting to a server engine.
If more than one protocol is specified, the initial connection time will be slower. When the first protocol
succeeds, that protocol is used for the remainder of the session.

Performance Tuning

Use cache engine: On

This setting specifies whether the client cache should be used. If this setting is Off, then the client
caches single records in a relatively small fixed-size cache on the client workstation. If this setting is
On, then the client uses the client cache engine, if it is loaded in memory. If the client cache engine is
not loaded, this setting has no effect. 
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The client cache is similar in many ways to the Workgroup engine. By default, it auto-loads into memory
when an application first accesses the database, and it unloads a few minutes after that application is
stopped. After the client cache engine starts, a tray icon appears, allowing you to control the client
cache from the Windows task bar. 

Some users may wish to keep the client cache in memory at all times, to avoid the performance cost of
re-populating the cache with each usage session. If you want to keep the client cache loaded, simply
start the Cache Engine from the Windows Startup group. 

By default you can find the client cache in the following location: Start  Programs  Pervasive.SQL
 Engines  Cache Engine. 

To stop the client cache, right-click on the client cache tray icon and choose Stop Engines and Exit. 

Pervasive.SQL keeps the client cache fully synchronized with the database engine cache and other
client cache locations. This behavior is entirely transparent, meaning that you should never need to
worry about what records are or are not in any given client cache. 

The following operations are not stored in the client cache: 

everything inside a transaction 
operations with a lock bias 
write operations such as insert, update, delete 
opens and close operations

NOTE: This setting has no effect if the "Allow Cache Engine connections"  on the server is set to off.

A few other important things about Pervasive:

If you cannot afford any downtime in the event of a system failure, Pervasive Data Exchange offers
replication that can offer hot backup. Having a slave site can also be used to run reports against,
without slowing down the main site with large queries.

If your business runs 24x7, continuous operations can be used. Pervasive also has a backup agent for
popular backup software. Refer to the Pervasive documentation for setting up continuous operations.

Defrag your server and workstation hard disks every 3-6 months for optimum performance.

Hopefully these extra settings and tips will be of help to you if you ever feel the need to change
Pervasive's default settings. For more information on Pervasive, please read the help manual that comes
with your installation.

http://www.pervasive.com
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4.1.4 Performance Monitoring

Introduction

For a majority of users, the Pervasive PSQL™ performs without the supervision of a database
administrator or IT staff, however, there are the occasional users who like to perform checkups or
monitor the health of their database and operating system on an as-needed or scheduled basis. With the
Microsoft Performance Monitor (PERFMON), users are able to quickly monitor the application and
detect key areas requiring further examination and tuning to ensure optimal 
application performance. Using this utility it is extremely easy to identify key application performance
areas and identify the additional tuning or optimization that may be required of the database.

This white paper focuses on extending the monitoring of the database process for Server (NTDBSMGR)
or Workgroup (W3DBSMGR) engines in an Microsoft Windows environment.

For users interested in monitoring the health and performance of the database, Pervasive utilizes the
Windows PERFMON to keep track of key counters and functions that interoperate between the
MicroKernal Database Engine (MKDE) and the Operating System. Regardless of the application access
methods — Btrieve , OLEDB, ADO, .NET, ODBC, etc. — all actions are recorded by the MKDE and
captured within the PERFMON logs to report reliable and accurate states.

Counter Configuration

In order to properly monitor or troubleshoot your system, users are able to conigure the Microsoft
PERFMON to record key areas of the Pervasive PSQL Microkernal Engine activity.

Performance analysis, using Microsoft’s PERFMON, will help you to better understand which areas
could be effecting your performance. Pervasive recommends monitoring the following items:

•  Handle Count – The total number of handles currently open by this process. This number is equal to
the sum of the handles currently open by each thread in this process.

•  Private Bytes – The current size, in bytes, of memory that this process has allocated that cannot be
shared with other processes.

•  Thread Count – The number of threads currently active in this process. Every running process has at
least one thread.

•  Virtual Bytes – Virtual Bytes is the current size, in bytes, of the virtual address space the process is
using.

•  Virtual Bytes Peak – Virtual Bytes Peak is the maximum size, in bytes, of virtual address space the
process has used at any one time.

•  Working Set – Working Set is the current size, in bytes, of the Working Set of this process. The
Working Set is the set of memory pages recently touched by the threads in the process. If free memory
in the computer is above a threshold, pages are left in the Working Set of a process, even if they are not
in use.

•  Working Set Peak – Working Set Peak is the maximum size, in bytes, of the Working Set of this
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process at any point in time.

Configuring a new Log Setting

In this example we’ll be running the Performance Monitor on a Windows 2003 Server system, with the
Pervasive PSQL v9.5 Server Edition.

To start, let’s open the Microsoft PERFMON utility.

1. Click on Start.
2. Select Run.
3. Type, “PERFMON” and hit Enter or click “OK.”

When you open Performance Monitor for the first time, it should look something like this:

 
Notice that there are three default counters. “Pages/sec,” “Avg. Disk Queue Length” and “% Processor
Time” are all pre-configured and actively monitoring your system.

Now we will add the counters that we want to track in addition to these default counters.

1.  In the left window pane, expand “Performance Logs and Alerts” and then click on “Counter logs.” You
will see “System Overview” appear in the right window pane.

2.  Right click in the window pane on the right side and select “New Log Settings.”
 
3.  We will name the new log “PSQL” for this demonstration, but you may give it any name you want.

4.  After you click “OK” for the name you have given to your new log setting, you will see a window like
this:



Technical Guide 67

© 2015 DocuData Software Corporation

5.  Click the “Add Counters” button.

6.  Change the Performance object to “Process” by selecting it from the drop-down list.

7.  On the bottom, right-hand side of the window, click next to “Select instances from list:” and choose: 
“ntdbsmgr” for the Pervasive Server Engine or “w3dbsmgr” for the Pervasive Workgroup Engine.

8.  On the bottom, left-hand side of the window, click next to “Select counters from list:”

9.  Hold down the Ctrl key while you select the following counters from the available list:
 
a. Handle Count 
b. Private Bytes 
c. Thread Count 
d. Virtual Bytes 
e. Virtual Bytes Peak 
f.  Working Set 
g. Working Set Peak

10. Click “Add” and then “Close” to return to the previous window.

11.  Click on the “Schedule” tab at the top of the current window and make sure that the Start logs and
Stop logs options are both set to “Manually (using the shortcut menu).”

12.  Click “Apply.”

13.  If the log folder does not exist, you’ll be prompted “Would you like to create it now?” Choose “Yes.”
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14.  Press “OK” to close the current window.
 
15.  Back in the main PERFMON window, you should see the new log you just created and configured.

16. Right click on the new log and select “Start” to begin this counter log.

17. When you are ready to stop monitoring the current counters, you can right click on the log you
created and select “Stop.”

Viewing an existing Log Setting

1.  Click on “System Monitor,” under Console Root in the left window pane of PERFMON.

2. Use Ctrl + L to bring up the System Monitor Properties window.

3. In the “Source” tab, under “Data source,” select “Log iles” and then click “Add.”

4.  Look for your log ile. By default the path is \perlogs\ile.blg.

5.  Select your log ile and click “Open.”

6.  Change to the “Data” tab.

7.  Remove the existing counters by highlighting each one and clicking on the “Remove” button just
below the “Counters:” window.

8.  Click the “Add” button to select the counters that you configured.

9.  You can hold down Ctrl while selecting each of the listed counters in the “Add counters from list:”
window and then click the “Add” button below.

10.  Click “Apply” and then “OK.”

You will now see the results of your counter log in the System Monitor window, which will look
something like this:
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Viewing Perfmon activity counters

If you want to simply forego recording the log ile, and you would rather just view the activity for the
counters, follow these steps:

1.  From the System Monitor window, choose Ctrl + I (or click on the Plus sign above the window).

2.  Change the Performance object to “Process” by selecting it from the drop-down list.

3.  On the bottom, right-hand side of the window, click next to “Select instances from list:” and choose
“ntdbsmgr” by clicking on it.

4.  On the bottom, left-hand side of the window, click next to “Select counters from list:”

5.  Hold down the Ctrl key while you select the following counters from the available list: 

a. Handle Count 
b. Private Bytes 
c. Thread Count 
d. Virtual Bytes 
e. Virtual Bytes Peak
f.  Working Set 
g. Working Set Peak

6. Click “Add” and then “Close” to return to the System Monitor window.

7.  If the graph appears to be frozen, you can use Ctrl + F to start the counter.



EDC RC Technical Manual70

© 2015 DocuData Software Corporation

Now that you have learned how to setup the Microsoft Performance Monitor, you can run your
application and monitor the Pervasive PSQL database engine activity.
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4.1.5 Pervasive.SQL Troubleshooting

Here are some tips in troubleshooting Pervasive.SQL problems:

If there is no database error and the database cannot be reached, trying pinging the database
gateway using its computer name and telnetting it on port 3351 using its computer name

When a Pervasive.SQL error code is obtained, the best source for researching the problem is the
Pervasive.SQL documentation. There is a link in the Start menu's Pervasive.SQL group.
Searching the help file with the index is the best way to locate the error code's explanations and
recommendations.

Very often, problems are resolved by restarting the Pervasive.SQL engine on the computer acting
as the database server.

The Pervasive.SQL's log file is located at %windir%\pvsw.log

Pervasive has an extensive Knowledge Base at http://www.pervasive.com that can help
troubleshoot problems.

http://www.pervasive.com
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4.2 Networking & Connectivity

If your installation of EDC RC is distributed over a network and you have firewalls managing the incoming
and outgoing connections you need to be aware of the default ports used by EDC RC and how to change
those default ports if the need arises.

Please refer to the section entitled "Installing EDC RC Services"  of the Install Guide for an
explanation on how to do this.

14
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4.3 EDC RC Services

Please refer to the section entitled "Installing EDC RC Services"  of the Install Guide for an
explanation of all EDC RC services.

14
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4.4 Replication

4.4.1 Replication Overview

This section explains how to install, configure, and manage the EDC replication engine.

The EDC Replication engine is the technology part of the EDC system which allows data
synchronization between a record center and the clients of the record center using the EDC Client
software.

Here are the major features of EDC Replication:

Uses a TCP/IP network layer, in other words, the Internet
Uses the http or https (secure socket layer) protocol
Uses XML-RPC (remote procedure calls) between EDC Client and EDC Record Center
Runs as background processes or services and requires minimal user intervention
Very easy to configure
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4.4.2 Installation at the record center

At the record center, the process EdcRpc.exe, is the server that handles the XML-RPC requests for
replication. This process may be installed as a service or executed on the command line as a regular
Windows process.

Executing as a regular process

By default, if it is executed without any command line parameters it will listen on TCP port 11003, and
work over the http protocol.

To run the server on a different port and activate SSL encryption, the following should be used:

EdcRpc. exe Por t No=14000 SSL=Yes

The parameters are not case sensitive.

Executing as a service

To install as a service, the following command must be used:

EdcRpc. exe - i ns t al l  Por t No=14000 SSL=Yes Cf gFi l e=C: \ EDC\ Bi n\ Dc. c f g

By default, the name of the service in the Service Manager, is "EDC_RPC". A different service name
may be specified using,

EdcRpc. exe - i ns t al l  Ser v i ceName=EDC_RPC_Ser ver 1 Por t No=14000 SSL=Yes
Cf gFi l e=C: \ EDC\ Bi n\ Dc. c f g

To uninstall the previously installed service,

EdcRpc. exe - uni ns t al l  Ser v i ceName=EDC_RPC_Ser ver 1

The ServiceName parameter is required with the -uninstall command if it was specified during the install
command.

For more information on how to setup EDC Services, refer to the "Installing EDC RC Services"
section of the Install Guide.

Connectivity with external clients

The IP address of the computer where the EdcRpc.exe process is executing must be accessible from
external internet connections, so appropriate firewall configuration must be made.

Configuration in the system information module

The system information module must be configured to indicate the connection parameters for EDC
Clients:

14
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These parameters will be set in the customer database when a customer is exported.

It is highly recommended to use SSL encryption. This is strong public key encryption.
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4.4.3 Managing the Replication at the Record Center

Viewing the current status of the Replication Server

From the Box and File Maintenance module, select File | Replication Log. This will query the replication
server and request its internal status log. This replication log will reset every time the process is
restarted.

If the EdcRpc.exe process is not started, a winsock error #10061 will occur.

View the date and time of the last replication session for all replicated customers

From the Box and File Maintenance module, select File | Replication Times. This will display a report of
all replicated customers and the last time they connected for a replication session.

Note: This report does NOT indicate a successful replication, only that a connection has been
made to the record center. To view the real status of a replication you need to view this same
information but on the client side. To view this open EDC Client, go to the "Box and File
Maintenance" module from the "Inventory" tab and then choose "File -> View Date and Time
of Last Replication".
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4.4.4 How does the replication work?

The replication process will synchronize the following data between the client and the record center:

Document types
Delivery address
Disposal, deletion, and transfer list status
Boxes
Files
Images

Document types are updated from the client to the record center. When a customer is replicated, the
conservation calendar may only be edited by the client using the client software.

Delivery address are updated from the record center to the client. Delivery addresses can only be added
or modified by the record center.

The list status are updated from the record center to the client. List status, for example, indicating a
destruction has been completed, may only occur at the record center.

Boxes and files replicate in both directions. When a boxes or file changes, it's entire content, including
notes and history, is copied to the remote site. If the same item is modified on both the client and record
center databases during the same session the client changes will have precedence and overwrite the
record center changes. This is a rare occurrence as replication generally occurs every 15 minutes.

PreAdd boxes and files may be deleted at both the client and record center sites, and the deletion will
be synchronized.

Boxes and files in the "in house" states are not synchronized with the record center. The record center
does not store information on "in house" items.

Boxes and files are synchronized sequentially based in the histories registered in EDC. Here is the list
of history activities that provoke a synchronization:

PreAdd
Out
Added
In
OnDispList
OnTransList
OnDelList
Deleted
Destroyed
Transfered
Sampled
Revised
SentToDepot
DeptChange
NumberChange
DescChange
TypeChange
Moved
AccessLevelChange
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DispositionChange
BoxChange
VolumeChange
UserField6Change
GeneralChange
BoxChange
PreAddDeletion
ImagesScanned
VaultTransition
ItemSetChange
AltLabelChange

Images may be scanned both in the record center and the client software when the client stores images
with the record center. If the client stores the images locally, images never get replicated with the record
center and the record center is not involved in the imaging. In order to implement imaging on demand,
images need to be stored at the record center.

Images are sequential within a file, starting at number 1, and increasing until the last image within the
file. If images are scanned in the same file at the same time (this is VERY unlikely, as the physical file
is probably in only one location), images scanned at the record center will be replaced by the images
that were scanned at the client.

When images are scanned in the client software, they will get replicated to the record center in the next
replication session. When images are scanned at the record center, only the image index gets
replicated to the client in the next replication session. In order to obtain the actual images, they have to
be downloaded from the Imaging module.

During a replication session the following events occur:

If the document types, delivery addresses, and list status have not been replicated in the previous 4
hours, they are synchronized as detailed above

Boxes deleted in the client database are deleted at the record center
Files deleted in the client database are deleted at the record center
Box changes in the client database are updated at the record center
File changes in the client database are updated at the record center
Box changes in the record center database are updated at the client
Files changes in the record center database are updated at the client
Boxes deleted at RC are deleted in the client database
Files deleted at RC are deleted in the client database
The image index in the client database is updated according to new images scanned at the record

center
Images scanned at the client are sent to the record center
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4.5 Printing

There is 2 different type of printing in EDC RC: Labels and Reports printing.

Reports Printing

When printing reports, EDC RC uses the default printer installed on your Windows machine. Here a
screenshot to illustrate:

So in the example here, it shows that my reports will be printed on my "printer on DDMTLDC01" printer
because it is the one set as my default printer. Any printer in this list could have been equally suitable
for the job including the PDF generators.

EDC RC internally uses ODBC drivers to achieve this report printing business. That is why when EDC
RC is installed, the installation process automatically creates a DSN entry in your computer like such:

http://sector7g.wurzel6.de/pdfcreator/index_en.htm
http://en.wikipedia.org/wiki/ODBC
http://en.wikipedia.org/wiki/Database_Source_Name
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EDC RC uses the name "EDC_RC" for its DSN name by default and you should not change it. If you do
change it you would have to start EDC RC with a special parameter called "dsn" which would supply the
name of the new DSN you want to use. Here's an example:
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Please refer to the section "Data Source Names(DSN) and ODBC"  to learn how to setup a DSN for
EDC RC from scratch.

Labels Printing

There are 2 ways to print labels in EDC RC:

- With thermal printers through either a serial interface or windows printer drivers
- With laser printers

Note: If you want to use either thermal printers through windows printer drivers or laser printers you have
to also edit the label templates for proper operations. Printing through thermal printers via the serial
interface is the only mode in which you don't have to and/or can't edit labels. In other words, if you need
to customize labels you can't use the serial interface.

Thermal Printers

To configure EDC RC to use a thermal printer, you need to modify the dc.cfg file usually located in the
bin folder of your installation. Although this file is editable with a regular text editor, most users usually
prefer to use the "EDC Setup" utility(dcsetp32.exe) also found under the bin directory. Once opened it
looks something like this:

92
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From here you can choose either "Direct Serial Printer" or "Windows Printer Driver". You would choose
"Windows Printer Driver" if your printer came with a windows driver and was installed on your machine
like any other regular printer would. The field here accepts either the printer name directly if the printer is
connected to your server or a UNC path if the printer is on a network (like in the example shown above).

The printer name is the name you see in the printer setup page shown here:

http://en.wikipedia.org/wiki/Universal_Naming_Convention#Universal_Naming_Convention


EDC RC Technical Manual84

© 2015 DocuData Software Corporation

In the case of this printer, the name is "\\DDMTLDC01\printer". You can access this page by going to
the "Box" module of EDC RC and go "File -> Print Setup" like so:

If you choose to print via the windows printer drivers, you also need to configure the label template for the
printing to work properly. The templates are located in the system information module:
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Refer to the EDC RC User's Guide if you need an explanation on how to modify the labels.

If you choose "Direct Serial Printer", here's what you first get:
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If you open the "Label Printer" drop-down field, you see the list of supported printers like so:
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If you thermal printer is connected directly to your server, you can choose of the 4 models shown in the
list. "Remote Printer" is NOT one of them (we'll talk about this next). Then you have to choose the COM
port on which it is connected to. Then just underneath the printer drop-down list(refer to the 2nd picture
up) there is an option called "High Speed" which you can select to make your printer print faster. Note
that this setting is only available for the printers that support it. The best thing to do here is simply to
enable it. If it's available on your printer you'll see a difference in speed and if it's not then you won't.
Either way it doesn't harm anything to put it on so just enable it.

If on the other hand your printer is located on another machine on a network, then you have to choose
the "Remote Printer" in the drop down list and enter the printer's IP address & port number in the
appropriate fields like so (the high speed option applies the same here):
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The port number 12077 is the default one and should not be changed. Let's see in more detail how all
this works. First here's a drawing that will help:
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It is the thermal print server that communicates with the label printer directly. The thermal print server
can be installed by itself as a regular process or service on any windows machine running Pervasive.

As you can see in the picture above, there is two dc.cfg files needed in this case: one to configure the
printer as seen from the EDC RC server standpoint and one as seen by the thermal print server
standpoint.

Since the printer is connected directly to the machine where the thermal print server is running, in the
config file "dc.cfg" the printer is set to a local "zebra" printer with the appropriate COM port.

The configuration from the EDC RC Server is set to a remote printer because the printer is NOT
connected directly to that machine. The IP address needs to be the address of the computer where the
thermal print server is running which in our drawing says it is 192.168.1.75. The port number is left to the
default of 12077, the port on which the thermal print server listens to for incoming print jobs.

That's about it for thermal printing! Next is just a note on laser printing.

Laser Printers

Laser printing was originally only available in the EDC Client software to allow customers to print their
own labels themselves but has been made available in EDC RC for convenience. The printing is done on
Avery sheets. EDC RC supports the following Avery models:

Letter (8.5 X 11in.)
5095
5159 through 5165
5197, 5198 & 5199
5260 & 5266
5960 & 5972

A4 (210 X 297mm)
L7159 through L7170
L7172 & L7173
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In order to use laser printers, you also need to configure the label template for the printing to work
properly. The templates are located in the customer information module:

Please refer to the EDC RC User's Guide if you need an explanation on how to modify the labels.

This concludes the section on printing.
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4.6 Language Dictionaries and Strings

EDC RC's graphical interface language can be changed if desired. EDC RC supports 4 languages but
only 2 can be used inside an installation at any one time. Here is the list of language combinations that
can be used:

English/French
English/Dutch
English/Spanish
Dutch/French

This section will show you how to install another dictionary combination into EDC RC and also how to
update the dictionary with new string definitions. Follow the links below for instructions:

Changing the dictionary used in EDC RC
Updating String Definitions in Dictionary

Changing the dictionary used in EDC RC

Here's the steps required to change the dictionary in EDC RC:

1. Obtain the new dictionary file from us by contacting support@docudatasoft.com
2. Make a backup of the file called "string.dat" located inside the "data" folder of your EDC RC

installation.
3. Rename the file you obtained from us to "string.dat" and put it in the "data" folder of your EDC RC

installation. Overwrite the old one with the new one when prompted.

The dictionary is now changed. Now if your new dictionary is anything other than "English/French" you
will also need to update the string definitions AND translate the new strings themselves in the dictionary.
Read the next section for instructions on how to do this.

Updating String Definitions in Dictionary

Follow the steps below to update the string definitions in the dictionary:

1. Obtain the new string definition update file from us by contacting support@docudatasoft.com
2. Make a backup of the file called "string.dat" located inside the "data" folder of your EDC RC

installation.
3. Rename the file you obtained from us to "string.dat" and put it in the "update" folder of your EDC RC

installation.
4. Go to the "bin" folder of your EDC RC installation and run the file "dimp32.exe".

Your dictionary is now updated with the new string definitions.

Note: If the language you use in EDC RC is anything other than English or French you will also need to
translate the new string definitions to match your language. Basically this only applies if you use either
Dutch or Spanish as your primary language in EDC RC.

Please refer to the section entitled "Language Dictionaries and Strings" in the EDC RC User's Manual on
our web site.

This concludes the section on Dictionaries and Strings.

91
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4.7 Data Source Names(DSN) and ODBC

This section of the manual shows you how to setup a DSN for EDC RC on the server from scratch in
case you would need to do so (you usually don't need to). For setting up a DSN on your local computer
to connect to the installation on the server have a look a the video below:

Creating a DSN entry for EDC RC

1- Go to the "ODBC Data Source Administrator". You can access this via 2 different places once
Pervasive is installed. Here's some screenshot that will help you find those:

Note: These screenshots were done on a windows 2000 machine. If you are running another version of
windows it might not be exactly in the same place but it should be close.

2- Browse to the "System DSN" tab and click the "Add" button. You'll then be prompted to choose a
driver for your new DSN. Choose "Pervasive ODBC Engine Interface" and click finish like such:

http://www.youtube.com/watch?v=GNkRwdfxLEQ
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NOTE: If you want to connect to data that is local on the machine your creating the DSN from,
you always choose the "Engine" interface. You only choose the "Client" interface when the
data is NOT located on your machine.

3- Next your presented with a window like this one:

Choose a name, enter it in the "Data Source Name" field and then press the "Create" button at the
bottom of the window. You'll then be shown another window like so:
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Choose a name for your database and enter it in the "Database Name" field. The name you choose can
only contain alphanumeric characters and start with a letter to be valid (otherwise it won't let you create
the database). Once you chose a name, deselect the option "Integrity Enforced" and then click the
"Browse..." button to choose your data folder.

Browse and choose the data folder of your EDC RC installation like so:

You'll then see that path appear in the 2 last fields of the form like so:
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Then press "OK" to close this window. You'll then be brought back to the main DSN setup window like
so:

Then test the connection by pressing the "Test" button. If all is well you should see a pop-up window
saying your connection is successful like so:
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Once this is confirmed you can press "OK" on both windows to close all this. You'll then be shown the
main ODBC administrator window with your new DSN listed like such:

Note: EDC RC uses the name "EDC_RC" for its DSN name by default and you should not change it. If
you do change it you would have to start EDC RC with a special parameter called "dsn" which would
supply the name of the new DSN you want to use. Here's an example:
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That's it for DSN's!
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4.8 Portable Data Terminal (PDT)

Build to collect, display and communicate data, the PDT is used in most of the operations of EDC RC
(ex: picking, refiling, moving and delivering items). Three PDT models are supported by EDC: the PDT
3100 (by Symbol), the PHL 2700, the PHL 1300 (by Opticon) and the Opticon H-13.

This section will show how to program, connect and configure those PDT's for use with EDC RC.
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4.8.1 Programming the PDT

If your PDT is not already programmed with our software you will need to install our program into it to
enable communications between the PDT and EDC RC.

If it is already programmed you can jump directly to the section on how to connect your PDT .

Each of the 3 PDT's have different instructions for programming them. Follow the appropriate link below
to program your particular model:

- Opticon PHL-2700
- Symbol PDT 3100
- Opticon PHL-1300
- Opticon H-13

Opticon PHL-2700

1. If the AppLoad (Application Loader) program from Opticon is not installed on your workstation,
download the application from:

 
http://docudatasoft.com/supportfiles/tools/appload.zip and install the application.

2. The PDT must be cold started using the following sequence:

Power off the unit
Hold the 0 (zero) and 7, press and release PW button

3. Select 3 Download Application, then chose between cradle or cable interface

Note: If transferring via the cradle, the dip switches below the cradle must be set 
as follows:
 
   1 ON
   2 OFF
   3 OFF
   4 OFF
   5 OFF
   6 ON

4. From the AppLoad program, Select File | Download, and select the PHL2700EN.S2 (english) or the
PHL2700FR.S2 (french) file depending on your language.

Note: These files are located by default in the "bin" folder of EDC RC.

If you cannot find them please contact support@docudatasoft.com to obtain new ones. Please
include the version of EDC RC you are using when requesting the file(s).

The transfer process will begin, and the program will automatically start after the transfer.

If transferring via the cradle when used with EDC, the dip switches below the cradle must be set as
follows:
 
   1 ON
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   2 OFF
   3 OFF
   4 ON
   5 ON
   6 OFF

Note: If the PDT needs to be restarted, the 0,7,PW boot sequence can be applied, and the
Restart option may be selected.

Your PDT should now be programmed. You can now jump directly to the section on how to connect your
PDT .

Symbol PDT 3100

If you don't have it already, download the PDT3100 package from:
 
http://docudatasoft.com/supportfiles/tools/pdt3100.zip and unzip it to a place convenient for you.

Preparing the PDT:

1. Turn the PDT off.
2. For the 35-key PDT press and hold the "SHIFT" and "BK SP" keys simultaneously.
    For the 46-key PDT press and hold the "F" and "I" keys simultaneously.
3. Press and release the "PWR" key.
4. Release other keys.
5. The PDT boots in "command mode".
6. Ensure the PDT is in the cradle.
7. Select Program loader with the up arrow, and confirm.
8. Set the communication parameters to 19200, 7 data bits, Odd parity, Xon/Xoff flow control.
9. Press "ENTER" to prepare the PDT to receive the firmware.

On the PC:

1. Edit the SendHex.bat(from the zip file you downloaded earlier on) and make sure the last parameter
on the line is the COM port number on your computer that the PDT is plugged into. The line should be
similar to:

SendHex Wanden 19200 2

Note: The "Wanden.hex" file can be found in the "bin" folder of EDC. If you cannot find it
please contact support@docudatasoft.com to obtain a new one. Please include the version of
EDC RC you are using when requesting the file.

This would mean that your PDT is connected to COM 2 at a baud rate of 19200.

2. Run SendHex.bat and press Enter when the PDT is in receive mode.

After the transfer:

1. The PDT must indicate Status 0000.
2. Turn the PDT off.
3. Boot the PDT with: 
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   - For the 35-key PDT press and hold the "SPACE", "FUNC" and "Up Arrow" keys simultaneously.
   - For the 46-key PDT press and hold the A and B and D keys simultaneously.
4. Press and release the "PWR" key.
5. Release the other keys.
6. The PDT will now boot in the EDC software.

Your PDT should now be programmed. You can now jump directly to the section on how to connect your
PDT .

Opticon PHL-1300

1. If the AppLoad (Application Loader) program from Opticon is not installed on your workstation,
download the application from:

 
http://docudatasoft.com/supportfiles/tools/appload.zip and install the application.

Note: the dip switches below the cradle must be set as follows before you can continue with
the next steps:
 
   1 ON
   2 OFF
   3 OFF
   4 ON
   5 ON
   6 ON

2. The PDT must be cold started using the following sequence:

Power off the unit
Hold the 1 (one) and , (dot), press and release PW button

3. Select 3 Download Application.

4. From the AppLoad program, Select File | Download, and select the PHL1300EN.S2 (english) or the
PHL1300FR.S2 (french) file depending on your language.

Note: These files are located by default in the "bin" folder of EDC RC.

If you cannot find them please contact support@docudatasoft.com to obtain new ones. Please
include the version of EDC RC you are using when requesting the file(s).

The transfer process will begin, and the program will automatically start after the transfer.

Note: the dip switches below the cradle must be set as follows before you can perform the next
step (configure and use with EDC):
 
   1 ON
   2 OFF
   3 OFF
   4 ON
   5 ON
   6 OFF
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Note: If the PDT needs to be restarted, the 0,.,PW boot sequence can be applied, and the
Restart option may be selected.

Opticon H-13

There are 2 cables linked together from the computer USB to the cradle.  There is the USB-Serial
adapter and the NULL Modem cable, which comes with the device.

If you decide to use the USB connection, you may need to download the driver from our web site and
install it with Administration privileges on your computer.  Otherwise, it will not work.

If you decide to use the serial connection, be sure to use the null modem cable, which came with the
H13.  Otherwise, it will not work.

1- Make sure the PDT is charged but turned off.

2- Set the dip switches under the cradle to:

   1 ON
   2 ON
   3 ON
   4 OFF
   5 OFF
   6 OFF
   7 OFF
   8 OFF
   
3- Make sure you copied the "h13en.hex" firmware file from the "bin" folder of 
EDC to your desktop. If you don't know how to get to
the "bin" folder, simply right-click on your EDC shortcut, go "properties" and 
then click on the "open file location" or "Find Target"
button. This will usually get you to the bin folder of EDC RC.

4- Make sure you have appload program installed on your computer. If you don't 
you can download it from:

http://docudatasoft.com/supportfiles/tools/appload.zip

5- Make sure Appload is set to use the proper COM port your PDT is connected to 
via the "settings -> port" menu.

6- Power up the PDT using the following sequence: 
  
Hold down the 1 (one) and .. (dot dot) buttons together then press and release 
the PW button (red button).

7- Select 3 Down. Software

8- From the AppLoad program , Select File | Download, and select the H13EN.HEX 
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you put on your desktop in point #3 above.

The transfer process will begin, and the program will automatically start after the transfer.

9- After transfer is done, remove the power adapter from the cradle and power it up again. Without this
step the PDT won't work.

10- Set the dip switches below the cradle back to:
 
   1 OFF
   2 OFF
   3 ON
   4 OFF
   5 OFF
   6 ON
   7 OFF
   8 OFF

Note: If the PDT needs to be restarted, but 1,.,PW boot sequence can be applied, and the Restart option
may be selected. This step is usually not needed.

Your PDT should now be programmed. You can now jump directly to the section on how to connect your
PDT .104
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4.8.2 Connecting the PDT

Whether your PDT is connected via a cable or a cradle, the principle is the same. You simply need to
connect it to a serial port that is usually located on the back of your computer.

Most standard computers nowadays come with at least 2 com ports "COM1" and "COM2". Refer to your
computer's documentation to know which is which.

Once plugged in, you need to tell EDC what port it is on by specifying it in the dc.cfg file. To do this you
open the file "dcsetp32.exe" located in the "bin" folder of your installation. Once opened you'll see a
window like so:

This is where you specify the COM port of your PDT for use in EDC RC.

That's it for connecting the PDT to your computer. Now let's configure the PDT  with EDC RC so it
can be ready for some real work.

105
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4.8.3 Configuring the PDT

********************************************************************************************************************
Note: Before you can configure the Opticon PHL-2700 PDT with EDC RC you need to make sure it is
set to communicate via cable or cradle depending on your particular setup. To verify this you:

1- Power up the PDT
2- Press option # 4 (Utilities)
3- Press option # 5 (Cable/Cradle)
4- Choose 1.Cradle or 2.Cable as appropriate for your setup.

********************************************************************************************************************

Note: The procedure for configuring the PDT is the same for all PDT models AND the two pre-
requisite steps "Programming the PDT"  and "Connecting the PDT"  are assumed to have
been done at this point.

To configure your PDT with EDC RC follow these steps:

1. Open EDC RC, go to the "Management" tab and then open the "System Information" module.
2. In System Information go to "File -> Configure PDT".

A window will open like so telling you to prepare your PDT for the data transfer(do NOT press the OK
button just yet or the transfer won't work!):

3. Put your PDT in receive mode by pressing # 1 (Receive) on your PDT.

4. Now you can press the OK button to start the data transfer.

99 104
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5. Once the transfer is done you should see the message "Transfer Complete" on your PDT.

That's it! Your PDT is now configured and ready to work in EDC RC. Congratulations!

This concludes the section on PDT's.
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4.9 SQL Reports

All reports in EDC RC are done internally via SQL statements. The reporting module uses ODBC drivers
to connect to the EDC RC database and therefore needs to have a DSN setup in order to function. When
EDC RC is first installed it automatically creates a DSN entry(by default it is called "EDC_RC") for the
report module so you don't usually need to set one up yourself.

If for any reason you wish to make one from scratch, refer to the section "Data Source Names(DSN) and
ODBC"  in this manual.

In the event that you decide to use another DSN name, you would have to start EDC RC with a special
parameter called "dsn" which would supply the name of the new DSN you want to use. Here's an
example:

This concludes the section on reports.

92



EDC RC Technical Manual108

© 2015 DocuData Software Corporation

4.10 Access Management

4.10.1 Controlling Access With DcLock32

This application(dclock32.exe) is normally used for three(3) different reasons:

Note1: You can find the dclock32.exe program in the "bin" folder of your EDC RC installation.

Note2: Specific users (either at the record center or at a client's site) can have access to this
program. To set up these users go in the Customer (for a client) or Management (for an
employee) section -> User Group | Employee Group  or Authorized user | Employee -> Edit ->
Edit, add the "Access Management" module to their list of accessible modules.

1- Terminate a customer and/or an employee's regular or locked sessions

A session is usually locked by the system when a computer crashes during an operation and the
number of users has been exceeded when a new session is opened. In this case the user cannot log
back into EDC. 

To remedy this situation open dclock32.exe and go "File -> Terminate all sessions" or "File -> Terminate
Customer sessions" like such:

The one you choose depends on if you want to terminate all the sessions including the employees
sessions or just a specific customer session. This will in effect terminate both active sessions and old
locked sessions from a previous crash etc..

Note: Often the session is not entirely locked, only one module cannot be accessed(but you can log
into the system). In this case, one can unlock operations in the System Information module like so:



Technical Guide 109

© 2015 DocuData Software Corporation

2- Lock & Unlock customers

If you want to lock or unlock access to EDC for a specific customer temporarily without having to change
his login information you simply open dclock32.exe and go "File -> Lock Customer" or "File -> Unlock
Customer" as required.

3- Lock & Unlock the whole EDC system

Another reason to use dclock32 is if you want to lock or unlock access to the whole EDC system for
everybody. This is usually done for maintenance reasons(updating EDC?) to make sure no one logs into
the system while the maintenance is being performed.

To do this simply open dclock32.exe and go "File -> Lock System" or "File -> Unlock System" as
required.

This concludes the section access management.
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4.11 Security

Because security is always a concern when networks are connected to the internet, EDC RC enables
you to transmit your communications from and to it using SSL encryption. To enable SSL encryption in
EDC RC just make that the SSL checkbox in the system information module is ticked. Here's a
screenshot to illustrate:

Note: This setting won't have any effect if you configured your RPC server(edcrpc.exe) with the
"ssl=no" option because the command-line arguments overrides the setting in the System
Information module.

Also be aware that TCP ports 11000, 11003 and 11007 need to have access to the internet so firewall
rules must be in place in your organization to allow incoming and outgoing traffic on these ports.

This concludes the section on security.
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4.12 Backup & Restore

This section will show you how to backup and restore of your EDC RC installation. You will be shown
how to do this both for operations that have a down time period and those who don't (24hours/day, 7
Days/week non-stop operations).

The 24hours non-stop backup and restore operation is called "Continuous Operations". If this is what
you are looking for you can jump straight to the topic by going here. The next section talks about the
normal backup & restore procedures.
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4.12.1 Normal Backup & Restore Procedures

This procedure is based on the fact that your operations are not always continuous 24hours/day. If this
is not your case and you operate 24hours/day then refer to the next section entitled "Continuous
Operations".

Note: Pervasive has some special settings that could be useful/important for backup & restore
operations. Of special interest to normal backups is the Pervasive feature called "Archival
Logging" which you should consider when doing a normal backup. Whether you backup &
restore in normal or continuous operations mode you should definitely have a look at their
documentation to insure all the proper steps are taken when doing your backup & restore
operations. Here's some links for this:

http://docs.pervasive.com/products/database/psqlv11/advops/wwhelp/wwhimpl/common/html/wwhelp.
htm#href=backup.08.4.html&single=true

Backup Steps

1. Make sure no one is using EDC RC
2. Shut down any EDC RC services or processes that may be running
3. Shut down all Pervasive engines (Transactional & Relational)
4. Backup your EDC RC installation folder on a medium appropriate for you (FTP, CD/DVD, Tape drive

etc..).

Note: On some installations, the "data" folder can be located in a different directory or machine than
your executables(bin folder). So just make sure you back it up as well if this is the case because a back
up without the "data" folder is in essence NO BACK UP AT ALL.

Just make sure that the backup is NOT stored on the same hard disk as your original EDC RC
installation because in the event of a disk failure you could loose everything which in some
instances could mean your whole business as well.

How to perform the actual backup is reserved for you to decide "how". Many utilities on the internet
already exist to perform backups and so it's not up to DocuData to decide for you which way to go on
this matter. The most primitive way would be to do a simple "copy & paste" of your installation folder on
the medium of your choice.

5. Restart your Pervasive and EDC RC services.

Your back up is now done!

Restore Steps

1. Make sure no one is using EDC RC
2. Shut down any EDC RC services or processes that may be running
3. Shut down all Pervasive engines (Transactional & Relational)
4. Restore(copy back) your EDC RC installation folder from your backup medium to its original location.
5. Restart your Pervasive and EDC RC services.

Your restore is now complete!

The next section shows you how to do your backup & restore when you have no down time (24hours/day
operations).

http://docs.pervasive.com/products/database/psqlv11/advops/wwhelp/wwhimpl/common/html/wwhelp.htm#href=backup.08.4.html&single=true
http://docs.pervasive.com/products/database/psqlv11/advops/wwhelp/wwhimpl/common/html/wwhelp.htm#href=backup.08.4.html&single=true
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4.13 Command-Line Parameters

Below is a listing of all command-line parameters, what they mean and with which executables they
belong. Unless otherwise noted, the command-line parameters always have the form "parameter=value"
so for example, starting the networklogin parameter would be written like "networklogin=yes".

Note: If you want to know what a particular executable is or what its function is you can refer to the
section entitled "EDC RC Component Listing"  later in this guide for an explanation.

Note: Parameters that have a "yes" or "no" as their possible values use the "default" value indicated
below if the parameter is not mentioned when starting the executable. 

Parameter Possible values Meaning Executables

networklogin yes or no
(default value is "no")

Enables you to use
your windows login

name to login into EDC,
bypassing the EDC

login screen.

docu32.exe
remo32.exe

cfgfile Path to dc.cfg file Indicates the location of
the configuration file

used for the executable

docu32.exe
remo32.exe

dclock32.exe
edcrpc.exe

edcclrpc.exe
licens32.exe
ordcheck.exe
ordmon32.exe
replicator.exe

thermalprintserver.exe
update.exe

servicename Any name you want as
long as there is no
space AND none of

these characters in the
name:

\ / : * ? " ' < > |
Usually it is preferable

to start the service
name with EDC to

easily differentiate them
from other windows

services.

Gives an alternate
name to the service
instead of using the

default built-in name of
the service.

edcrpc.exe
edcclrpc.exe

ordmon32.exe
replicator.exe

thermalprintserver.exe

portno Any port number above
1024

Assigns an alternate
port number for the

executable to
communicate on

instead of using the
default built-in port for

the service.

edcrpc.exe
edcclrpc.exe
replicator.exe

ssl yes or no Indicates whether or not edcrpc.exe

120
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(default value is "no") SSL encryption will be
used to communicate
with the executable.

edcclrpc.exe
replicator.exe

replicationinterval A number indicating the
number of minutes

between replications 

Defines the number of
minutes between

replications

replicator.exe

start A time in the 24H
format

(example -> 22:30) 

Defines at what time
the replication process
should start every day.

replicator.exe

stop A time in the 24H
format

(example -> 22:30) 

Defines at what time
the replication process
should stop every day.

replicator.exe

threadindex yes or no
(default value is "yes")

Dictates if the
application will be

"indexing" or not the
modified information
from the box and file
modules for full text

searches.

docu32.exe
remo32.exe

threadrecipient yes or no
(default value is "yes")

Dictates if the
application will be

"indexing" or not the
newly  added order

recipients for the auto-
fill ordering feature.

docu32.exe
remo32.exe

exportddf yes or no
(default value is "no")

When set to "yes" this
option locks the

database DDF files
(hides some tables in

the db). This parameter
is usually used after a

troubleshooting session
that needed to have

some tables unlocked
for the troubleshooting

process.

docu32.exe
remo32.exe

rcrpchost IP Address or URL of
machine running

edcrpc.exe

Used to connect
edcclrpc.exe to edcrpc.

exe.
This option is needed

by the executable
ONLY if the edcrpc.exe

is not located on the
same machine.

edcclrpc.exe

rcrpcportno Port number that
edcrpc.exe

communicates on

Used to connect
edcclrpc.exe to edcrpc.

exe.

edcclrpc.exe
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This option is needed
by the executable

ONLY if the edcrpc.exe
is not located on the

same machine.

rcrpcssl yes or no
(default value is "no")

Used to connect
edcclrpc.exe to edcrpc.

exe.
This option is needed

by the executable
ONLY if the edcrpc.exe

is not located on the
same machine.

edcclrpc.exe

new No other values needed Use this option to
create a new empty dc.

cfg file. Usage is like
so:

dcsetp32.exe new

dcsetp32.exe

setimagedirectory Path to Image directory
Note that this

parameter has no
delimiter between
itself and its value.

Here's a usage
example:

"setimagedirectoryC:
\images"

This option is used only
if you want to override
the image directory

setting from the system
information module.
This is rarely used.

docu32.exe
remo32.exe

setedmdirectory Path to main EDM
directory

Note that this
parameter has no
delimiter between
itself and its value.

Here's a usage
example:

"setedmdirectoryC:
\edm"

This option is used only
if you want to override

the EDM directory
setting from the system

information module.
This is rarely used.

remo32.exe

setuserworkdirectory Path to User's work
directory. The User's
system number from
the RC side needs to
be included as well.

Usage example:
setuserworkdirectory

('user system # ', ' Path
to work directory')

This option is usually
used to override the

user's working directory
set in the Authorized

User module.
Rarely used.

remo32.exe

importdescfile Path to import
description file and its

Usually used when
doing importation from a

docu32.exe
remo32.exe
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log file. Usage is as
follows:

importdescfile('path to
import file', 'path to log

file')

batch file or something
similar.

The same operations
are usually done from

within EDC itself.

emaillog: [email address]:
[number of past days]

example:
a@a.com:2

So in this example, 
a@a.com would be
emailed the error log
from the last 2 days

(NOT including today)

This option is used to
have the EDC error log

being automatically
emailed to you.

docu32.exe
remo32.exe

imageimportfolder Path to image folder to
import. The image
folder needs to be

named according to the
import convention.

Refer to the EDC RC
User's Guide for more

information on this.

Used to automatically
import images when the
executable is launched.
This option is usually

used in conjunction with
the "imageimportlog"

option below(but
optional).

docu32.exe
remo32.exe

imageimportlog Path to where you want
the log file to be

created.

This option is usually
used with the

"imageimportfolder"
option above but is
optional. It defines
where the import

process will store the
log file of the import.

docu32.exe
remo32.exe

CreateEDMUserFolders No other value required This option creates
EDM user's directories
for all users defined in
the Authorized Users

module. This is usually
only used when first

setting up the
application.
Rarely used.

remo32.exe

This concludes the section on command-line parameters.
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4.14 Default Port Numbers

EDC servers processes have some default ports associated with them. You will find this information here
. 15
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4.15 Uninstalling EDC RC

Uninstalling EDC RC can have serious consequences for your business if not done properly. Therefore
we recommend that you DON'T attempt an uninstall by yourself. Instead give a call to our support team
for assistance at 1-877-789-2789 (Calling from North America) or +1(514)789-2789 (Calling from
anywhere else in the world).
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4.16 EDC RC Component Listing

This is a list of applications used by EDC RC to perform specific tasks. All these executables are
located in the "bin" folder of your EDC RC installation.

CUSTWEB.EXE : This application is now deprecated in favor of our new web application called
ActiveWeb.

DCLOCK32.EXE : This application is normally used when one needs to unlock locked sessions. A
session is usually locked by the system when a computer crashes during an operation and the number
of users has been exceeded when a new session is opened. This application can also be used to lock
access to the whole EDC system or specific users from accessing it.

DCSETP32.EXE: This application is used to modify the DC.Cfg file (this is the configuration file that
points out the Data, Update & Temporary directories of EDC RC plus some additional printer and PDT
settings). 
    
DIMP32.EXE :  This application is used when one needs to update the dictionary used by EDC (this is
specifically for the fields and the menus of the software). The data of the dictionary is stored in a file
called "String.dat" in the data directory.

DOCU32.EXE: This is the main application that starts EDC RC. 

EDCCLRPC.EXE: This is a server program that will be used with the upcoming ActiveWeb software.
ActiveWeb is to EDC Client what ActiveWeb is to EDC RC.

EDCMONITOR.EXE: This application monitors the dispatcher program. It verifies if new changes were
done in EDC and sends them to another program (specific to one of our clients).

EDCREP32.EXE : This application is now deprecated in favor of our new replication process
(replicator.exe).

EDCREQIP.EXE : This application is now deprecated in favor of our new replication process
(replicator.exe).

EDCRPC.EXE :  This application allows EDC programs as well as other programs to communicate with
EDC. 

EDCSER32.EXE : This application is now deprecated in favor of our new replication process
(replicator.exe).
 
EDCSERIP.EXE : This application is now deprecated in favor of our new replication process
(replicator.exe).

EDCSHL32.EXE :  This application launches other EDC programs. Usually the launcher runs the
following programs: imgser32.exe, replicator.exe, edcrpc.exe.   

IMGSER32.EXE: This application is an image server, that is used for digital imaging. 

LICENS32.EXE: This program allows installing the license for the software. Works with both RC and
Client version. For example, if the client wants to increase their number of users, or move from the SA to
SAI version of the software, the license we give them will be entered in this program.
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ORDCHECK.EXE : This application is responsible of informing you when the Order Monitor
(ORDMON32.EXE) is not working.

ORDMON32.EXE : This application monitors incoming orders and notifies the record center's personnel
when rush orders are entered. 

RCKEYGEN.EXE: Program that must be executed only once at each record center. It will create
random encryption 
keys to allow secure replication between the record center and its clients.

REMO32.EXE: This is the main application that starts EDC Client. 

THERMALPRINTSERVER.EXE: Program that allows configuring in DcSetp32.EXE a thermal printer that
is installed on a specific machine identified by an IP address.

UPDATE.EXE: This application is used when updating the software.



EDC RC Technical Manual122

© 2015 DocuData Software Corporation

4.17 Troubleshooting

This section will guide you in what to do when some known problematic situations arise. Refer to the
relevant links below for more information on how to proceed.

Mismatched application and/or database level warnings
EDC, ActiveWeb and Pervasive error log files

Mismatched application and/or database level warnings

Sometimes EDC RC needs to have only it's database level upgraded to match the application level. This
is a rare instance but it can happen from time to time. You will usually be made aware of this when you
attempt to open EDC RC and it fails with a message looking like:

Here's how you can remedy to this situation:

Note: We highly recommend that you backup your installation of EDC RC before attempting
any updates like this one.

1. Obtain the database level update file from us by contacting support@docudatasoft.com

Note: The name of the update file has the level update number in it so in the example above
you would receive a file called "rc001059.exe".

2. Put the update file in the "bin" folder of your EDC RC installation.
3. Run the file and follow the instructions on the screen.

Your database is now to the same level as your application and can function properly.

Although very unlikely, the opposite error message can also appear (database level above the application
level). If this situation occurs contact us by email at support@docudatasoft.com for help.

EDC, ActiveWeb and Pervasive error log files

Usually most error events get logged in log files. These log files can come in very handy when
troubleshooting a problem. You will also find that most of the time when you contact us for support we
will ask you for those log files.

122
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Here is a listing of the error log files that are important for troubleshooting or debugging purpose and
where to find them:

Log File Name Where To Find It

Main EDC RC error log(no name) From the main window of EDC RC you browse to
the menu

Help -> View Error Log

edclog.txt
(only information that couldn't get logged in the
main error log file gets logged here. This usually

happens when a connection to the database
couldn't be established)

Located in the windows folder
For Windows 98, XP and Server2003: C:

\Windows
For Windows 2000: C:\WINNT

Main Replication Log(no name) From the "Box and File Maintenance" module of
EDC RC(Maintenance Tab) you browse to the

menu
File -> Replication Log

edcreplog.txt
(only information that couldn't get logged in the
main replication log file gets logged here. This

usually happens when a connection to the
database couldn't be established)

Located in the windows folder
For Windows 98, XP and Server2003: C:

\Windows
For Windows 2000: C:\WINNT

pvsw.log(Pervasive Error Log) Located in the windows folder
For Windows 98, XP and Server2003: C:

\Windows
For Windows 2000: C:\WINNT

admin, host-manager, jakarta_service, stout,
stderr, localhost, catalina & manager log files

(you might not have every one of them available
all the time)

These are the log files of Tomcat needed during
troubleshooting sessions of ActiveWeb

These are located in the "logs" folder of Tomcat
which in a standard installation can usually be

found in:
C:\Program Files\Apache Software

Foundation\Tomcat 5.5\logs

This concludes the section on troubleshooting. 
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